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SnapScan™ e42/e52

Owner’s Guide

! Preface

This chapter gives you information about SnapScan and about How to Use this Online Guide.

! Chapter 1: Preparing the Scanner

“Preparing the Scanner” explains how to prepare your SnapScan for installation.

! Chapter 2: Installing the Scanner for PC

This chapter shows you how to set up your SnapScan for your PC.

! Chapter 3: Configuring Buttons on Your PC

This chapter shows you how to configure your SnapScan Buttons on your PC.

! Chapter 4: Installing the Scanner for Macintosh

This chapter shows you how to set up your SnapScan for your Macintosh computer.

! Chapter 5: Configuring Buttons on Your Macintosh Computer

This chapter shows you how to configure your SnapScan Buttons on your Macintosh
computer.

! Chapter 6: Making Your First Scan

Here you find instructions on how to place reflective originals on the glass plate of your
scanner.

! Chapter 7: Using the Transparency Module (SnapScan e52)

Here you find instructions on how to use the transparency module to scan negatives,
transparencies or slides.

!  Appendix A: Troubleshooting

“Troubleshooting” can be helpful when you come across problems.

! Appendix B: Technical Information

This appendix provides specifications for your SnapScan.

! Appendix C: Regulation Compliance

This appendix gives you information about safety regulations and electromagnetic
compatibility.
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About SnapScan
In this Owner’s Guide, the name SnapScan is used for both the SnapScan e42 and e52.

The SnapScan is a one pass flatbed color scanner with a resolution of
1200 x 2400 ppi equipped with a cold cathode lamp. It is based on CCD (Charge-Coupled Device)
scanning technology. With the SnapScan, you can scan line-art, gray-scale and color reflective
originals up to A4 format. With the SnapScan e52 you can also scan negatives, transparencies or
slides.

The scanned data is transferred through the computer’s USB (Universal Serial Bus) port. The USB
technology makes it easy to install multiple peripherals to your computer. USB eliminates any need
to turn off or restart the computer when attaching a new peripheral.

SnapScan is a scanner that captures and converts reflective originals (for example pictures, text)
into electronic data that can be used in computer applications. With the SnapScan e52 you can also
scan negatives, transparencies or slides. It offers high-resolution image capturing and is an ideal
tool in making presentations come to life.

SnapScan supports multiple scanning modes and includes scanner software to get you started right
away. With its powerful and easy-to-use scanner driver software, SnapScan gives you easy access
to high-quality color scans. The scanner driver software gives you a number of additional features
to create special effects or to reproduce even the most difficult originals.

The document cover is adjustable: when you put a thick original (like a book or a magazine) on the
reflective glass plate, the document cover adapts to the thickness of the original.

Environmental Requirements
" Place the scanner on a horizontal, flat surface.

" To ensure proper ventilation, allow a minimum of 10 cm (4 inches) free space around each
side of the scanner.

" Make sure that no vibrations or shocks occur.

" Make sure that the area is free of dust.

" Avoid any contact with water. Do not use your scanner near water or in a damp environment.

" Your SnapScan is designed to perform at best when the environmental humidity is between
20% and 85%. Avoid environments where humidity fluctuations might occur.

" Your SnapScan is designed to perform at best when the environmental temperature is
between 10 °C (+ 50 degrees Fahrenheit) and 40 °C (+104 degrees Fahrenheit). Avoid
exposure to direct sunlight and heating devices.
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Precautions
For your own safety and that of your equipment, respect conscientiously the Environmental
Requirements and always take the following precautions:

" Check frequently whether there is no overheating of the AC adapter.

" If you do not use your scanner for some time, pull the AC adapter cable out of the power
supply socket.

" Handle your SnapScan with care: the glass plate is fragile. There is no warranty on breaking
the glass plate and your dealer is not liable for consequential damages.

" Disconnect the AC adapter when you want to clean the scanner housing or the glass plate and
when the scanner needs servicing or repairing.

" Do not open the scanner housing as it contains high-voltage areas and sensitive components.
Every repair should be carried out by your dealer.

" Do not leave originals on the reflective glass plate for excessive periods of time. The warmth of
the scanner may cause them to deteriorate.

" For safety reasons, never use extension cables for the AC adapter.

Caution: For safety reasons, besides the personal maintenance mentioned in this Owner's Guide,
do not try to remove any mechanical parts or any electronic components from your scanner. If your
scanner needs service, our dealer and service offices are available to help you.

Cleaning your Scanner
" Cleaning the glass plate regularly, ensures that dirt or smudges do not reduce the quality of

your scanned images.

" Before cleaning, disconnect the AC adapter from your scanner.

" Use a soft damp cloth and a mild detergent to clean the surface of the glass plate. If you use
alcohol to clean the glass plate, make sure that you do not touch the plastic elements of the
scanner.

" Avoid using sprays directly onto the glass plate as this may cause the liquid to penetrate the
seams around the glass and contaminate the mirrors and lenses inside the scanner.

" Do not use liquid cleaners or aerosol cleaners.
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How to Use this Online Guide
To … Click …

jump to another location within or outside the
document

blue text

jump to a topic in the document click the corresponding bookmark

jump to the first or the last page
 

retrace your steps in the document
 

jump to the previous or to the next page
 

zoom in and zoom out (control-click) on the
page

search for a part of a word, a complete word
or multiple words

print the document

# Note: Due to rescaling, some of the screenshots included in this document may appear
unclear when displayed at 100% magnification. You can view these screenshots more clearly
by using the Zoom tool to increase the default magnification.

How to Print this Guide
1 Choose Page Setup from the File menu.

2 Choose your paper format from the Paper popup menu.

3 Select Orientation: Portrait.

4 Click OK.

5 Choose Print from the File menu.
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Chapter 1: Preparing the Scanner

This chapter helps you to prepare your SnapScan for installation.

! Unpacking the Scanner

! Taking a Closer Look

! Changing the Handle

! Changing the Button Cap

! Unlocking the Scanner
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Unpacking the Scanner
1 Open the packing box and carefully unpack all the items.

2 Check each item to make sure that everything listed on the Packing List (printed on the box) is
present. Check if there is no visible defect.

If something is missing, contact your dealer.

3 Remove the plastic wrapping and the packing materials from the scanner.

# Note: Do not throw away the packing materials. They can be useful to protect the scanner
during later transport.

Taking a Closer Look
When you have taken the scanner out of the box, take a closer look at its parts. The following
figures illustrate the different parts of your SnapScan.

SnapScan e42:

1

3

2

4

5 6 7 8

9

1. replaceable handle

2. adjustable document cover

3. glass plate

4. replaceable button cap

5. e-mail button

6. print button

7. ScanWise button

8. OCR button

9. status indicator
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SnapScan e52:

1

4

5

3 2

6

7 8 910

11

1. replaceable handle

2. adjustable document cover

3. transparency lamp cover (for
reflective scanning)

4. transparency module

5. glass plate

6. replaceable button cap

7. e-mail button

8. print button

9. ScanWise button

10. OCR button

11. status indicator

12. holder for scanning slides

13. holder for scanning
negatives/transparencies

12

13
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The following figure illustrates the location of the different ports at the rear of your scanner
(SnapScan e42/e52).

1 2 3

1. USB Port (labeled with the USB icon ) to
make a connection to your computer

2. Transparency Module Port (SnapScan e52
only)

3. Power connector

Changing the Handle
It is possible to customize your SnapScan by changing its handle.

1 Press the two clips at the inside of the cover upwards and lift the handle.
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2 Remove the handle by sliding it out of its lip.

3 Choose a new handle.

4 Slide the handle in the lip.

5 Press the front of the handle down until you hear a click.
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Changing the Button Cap
It is possible to customize your SnapScan by changing the button cap.

1 Open the button panel by pushing the button cap.

2 Pull out the upper part of the button cap.

3 Remove the button cap by lifting it at the underside and sliding it out of its lip.
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# Note: Do not remove the button cap while the button panel is still closed.

4 Choose a new button cap.

5 Press the upper part of the button cap over the button panel into the scanner.

6 Press the underside of the button cap in the right position.

Unlocking the Scanner
Before you start using the scanner, you first have to unlock it.

1 Place the scanner on a horizontal, flat surface and pull it carefully towards you until you can
see the locking slider at the bottom.

2 Slide the locking slider to the right.

Your scanner is unlocked.

# Note: If you want to transport your scanner, you have to lock it. To do this, first connect the AC
adapter to the scanner so that its optical assembly moves to its home position. Then, slide the
locking slider to the left and disconnect the scanner. Your scanner is now locked and ready for
transportation.

Caution: Make sure to install the ScanWise software before connecting the scanner to your PC or
Macintosh computer.
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Chapter 2: Installing the Scanner for PC

This chapter shows you how to set up your SnapScan for your PC.

! Minimum System Requirements

! Installing the Scanner Software

! Connecting the Scanner to Your PC

! Installing Additional Software
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Minimum System Requirements
" A USB port

" A Pentium® processor

" A 14 inch color monitor

" A video card that can display a minimum of 16 bit high color

" 64 MB of RAM

" A CD-ROM drive

" Windows® 98

" ScanWise is compatible with all IBM™ PCs and compatibles running
Windows 98/Me/2000

" The amount of disk space available on your PC determines the number and the size of the
images that you can scan. Make sure that you have enough free storage space on your hard
disk. You need about two times the size of the image to scan, edit and save it.
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Installing the Scanner Software
1 Insert the Agfa ScanWise CD-ROM in your CD-ROM drive.

# Note: If the ScanWise Installer program does not appear automatically, carry out the
following instructions:

1 Double-click My computer.

2 Double-click the CD-ROM drive.

3 Double-click Setup.exe.

2 If you want to use ScanWise in another language, click the language button to select a
language.

# Note: If you choose another language, that language will be used for all the
documentation.

3 Click Install Agfa ScanWise.

Follow the instructions on your screen.

# Note: After installation the Register ScanWise window appears. You can choose to register
now or later.

$ Register now: If you choose to register now, the Agfa webpage opens. Here you can
register on line.

$ Register later: If you choose to register later, you can register afterwards via
Start/Programs/Agfa ScanWise/Register ScanWise.
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By registering on line, you will create your personal e-Service account and you will enjoy the
following benefits:

1. Customized self-help tools:

You have access to the following self-help tools which are customized according to your
e-service account profile:

$ Software downloads

$ Technical knowledge database (FAQ)

$ On line manuals and documentation

$ Access to third-party software support sites

2. Personalized one-to-one technical support:

Agfa assists you on line if you have additional questions about technical issues.

3. Automatic e-mail notification:

Agfa notifies you immediately when new software and upgrades are available for downloading.

# Note: For support issues, go to http://support.agfa.com.

# Note: For the latest information consult the ScanWise Read Me File.

4 Click Install Adobe Acrobat Reader to install this program, if needed.

You need Adobe Acrobat Reader to read the SnapScan documentation.

http://support.agfa.com/
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5 Click View the ScanWise movie to see the demo.

6 Click Install additional software to install software that helps you to organize and adjust your
digital images and to create your personal Web pages (see Installing Additional Software).

When the (additional) software is installed you may be asked to restart your computer.

You are now ready to connect the scanner to your computer.
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Connecting the Scanner to Your PC

Caution: For your safety, use the adapter that comes with this product. Do not use any substitute.
Misuse of the power adapter can cause serious damage to the product and a safety hazard while
using it.

# Note: Check if the AC Adapter complies with your local power supply.

# Note: Make sure the scanner is unlocked (see Unlocking the Scanner) before connecting it to
the electric outlet.

1 Connect the Transparancy option as shown in the figure below (e52 only).

2 Connect the plug of the AC adapter to your scanner.

3 Plug the adapter cable in the wall outlet.

4 Connect one end of your USB cable to the USB port on your scanner. Make sure you connect
the correct plug as shown in the figure below.

5 Connect the other end of your USB cable to a USB port on your computer. Make sure you
connect it to the correct port as shown in the figure below. A USB port is labeled with the USB
icon .

Windows will now detect the scanner and will install the necessary files for the scanner
hardware driver.
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Installing Additional Software
If you want to use OCR (Optical Character Recognition) you will have to install Readiris. Insert the
CD-ROM and follow the instructions on your screen.

If you want to use an image editing tool you can install Adobe Photoshop LE. Insert the CD-ROM
and follow the instructions on your screen.

# Note: If the Installer Program does not appear automatically, double-click the Setup.exe file on
your CD-ROM.

The Agfa ScanWise CD-ROM contains software to organize and adjust your digital images and to
create your personal Web pages. Insert the Agfa ScanWise CD-ROM and install the desired
application(s):

" email VoiceLink Basic (trial version): to add your voice, photos and graphics to email.

" Photo Explorer: to acquire, view, organize and adjust digital images and video’s.

" PhotoImpact (trial version): to edit digital images and create Web pages.

" Web!Personal: to create your personal Website.

# Note: You do not need to restart your computer after the installation of Web!Personal and
Photo Explorer.

For a general overview of the possible workflow, please consult the ScanWise modes document,
that is supplied with your scanner.
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Chapter 3: Configuring Buttons on Your PC

! Selecting a Different ScanWise Configuration

! Modifying an Existing Configuration

! Creating a New Configuration

! Modifying the ScanWise Settings
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Selecting a Different ScanWise Configuration
It is possible to assign a different configuration to one of the four buttons of your SnapScan. The
following example will show you how this is done.

In this example we will change the settings of the e-mail button into a configuration that will send
the scanned image to a file.

1 Open the Agfa ScanWise software.

2 Select Configure Buttons from the Tools menu.

The Configure Buttons window appears.

a. e-mail button

b. print button

c. ScanWise button

d. OCR button

3 Click the drop-down list next to the e-mail button.

4 Select Scan Image to File (autoselect).

5 Click OK.

Pushing the e-mail button will send the scanned image to a file instead of to your mail
recipient.

# Note: The same procedure can be applied to the print, ScanWise and OCR button.
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Modifying an Existing Configuration
It is possible to modify an existing configuration and assign it to one of the four buttons of your
SnapScan. The following example will show you how this is done.

In this example we will change the settings of the e-mail button into a configuration that will send
the scanned image to a file.

1 Open the Agfa ScanWise software.

2 Select Configure Buttons from the Tools menu.

The Configure Buttons window appears.

a. e-mail button

b. print button

c. ScanWise button

d. OCR button

3 Click Organize.

The Organize Actions window appears.
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The Organize Actions window displays all predefined and user defined configurations.

# Note: Remove will be enabled when a user defined action is selected. The default actions
cannot be removed.

4 Select Scan Image to File (autoselect).

5 Click Edit to modify the selected configuration.

The Settings For window appears.
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a. All predefined settings are available via the different drop-down menus.

b. The resolution depends on the choice of destination.

c. The output dimensions can be managed via the Dimension drop-down list.

# Note: There are several options to edit the existing configuration. For more information see
Modifying the ScanWise Settings.

6 Click Save As.

The Save Action Configuration window appears.

7 Enter the name of your configuration.

8 Click OK.

You return to the Settings For window.

9 Click OK.

You return to the Organize Actions window and your configuration will be added to the Actions
list.

10 Click Close.

You return to the Configure Buttons window.



Chapter 3: Configuring Buttons on Your PC 28

11 Select My Scan Image to File (autoselect) from the drop-down list next to the e-mail button.

12 Click OK.

Pushing the e-mail button will send the scanned image to a file instead of to your mail
recipient.

# Note: For low quality originals (originals that are too bright or too dark), we advice you to select
the PhotoGenie check box, which will enhance the colors.

Creating a New Configuration
It is possible to create a new configuration and assign it to one of the four buttons of your
SnapScan. The following example will show you how this is done.

In this example we will create a new configuration and assign it to the e-mail button.

1 Open the Agfa ScanWise software.

2 Select Configure Buttons from the Tools menu.

The Configure Buttons window appears.

a. e-mail button

b. print button

c. ScanWise button

d. OCR button
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3 Click Organize.

The Organize Actions window appears.

The Organize Actions window displays all predefined and user defined configurations.

# Note: Remove will be enabled when a user defined action is selected. The default actions
cannot be removed.

4 Click New in the Organize Actions window.

The Settings For window appears.
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a. All predefined settings are available via the different drop-down menus.

b. The resolution depends on the choice of destination.

c. The output dimensions can be managed via the Dimension drop-down list.

# Note: There are several options to create a new configuration. For more information see
Modifying the ScanWise Settings.

5 Select the settings that you want to apply.

6 Click Save As.

The Save Action Configuration window appears.

7 Enter the name of your configuration.

8 Click OK.

You return to the Settings For window.

9 Click OK.

You return to the Organize Actions window and your configuration will be added to the Actions
list.
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10 Click Close.

You return to the Configure Buttons window.

11 Select your new configuration from the drop-down list next to the e-mail button.

12 Click OK.

The e-mail button is configured with your personal settings.

Modifying the ScanWise Settings
There are several options to edit an existing configuration or to create a new one.

In the Settings For window following options are available:

" Original Type, Destination, Selection and Color Mode: These options can be changed using
the different drop-down menus.

" Use PhotoGenie: Select the check box Use PhotoGenie if you want to activate the PhotoGenie
software that will enhance both color and detail of your scanned image in case it is too bright or
too dark.

" Resolution: The resolution depends on the destination. If you select your printer as a
destination, the resolution of your printer destination will be shown in the resolution box.
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" Dimension: If you want a specified output range, click the Dimension drop-down list. A list of
additional options will appear. Select the dimension (width or height) you want to specify. Enter
the desired range and select the correct unit from the drop-down list. The Keep original size
selection will keep the original size of the image.
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Chapter 4: Installing the Scanner for
Macintosh

This chapter shows you how to set up your SnapScan for your Macintosh.

! Minimum System Requirements

! Installing the Image Editing Software

! Installing the Scanner Software

! Connecting the Scanner to the Macintosh Computer

! Installing Additional Software
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Minimum System Requirements
" A USB port

" A PowerPC® processor

" A 14 inch color monitor with thousands of colors for an accurate display of color images

" 64 MB of RAM

" A CD-ROM drive

" Mac® OS 8 or higher

Installing the Image Editing Software
1 Disable the virus protection software.

You can turn it off in the Extensions Manager Control Panel or you can drag the software out of
the System Folder.

# Note: After installing, enable the virus protection software again.

2 Restart your computer.

3 Insert the Mac CD-ROM of Adobe Photoshop LE.

4 Double-click the Adobe Photoshop LE icon.

5 Follow the instructions on your screen.
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Installing the Scanner Software
1 Insert the Agfa ScanWise CD-ROM in your CD-ROM drive.

The Agfa ScanWise window appears.

2 Double-click the ScanWise Installer icon.

# Note: If the ScanWise window does not appear automatically, carry out the following
instructions:

1 double-click the CD-ROM icon on your desktop.

2 Double-click the ScanWise Installer icon.

3 If you want to use ScanWise in another language, click the language button to select a
language.

# Note: If you choose another language, that language will be used for all the
documentation.

4 Click Install Agfa ScanWise.

Follow the instructions on your screen.

# Note: After installation the Register ScanWise window appears. You can choose to register
now or later.

$ Register now: If you choose to register now, the Agfa webpage opens. Here you can
register on line.

$ Register later: If you choose to register later, you can register afterwards via Agfa
ScanWise/Product Registration.
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By registering on line, you will create your personal e-Service account and you will enjoy the
following benefits:

1. Customized self-help tools:

You have access to the following self-help tools which are customized according to your e-
service account profile:

$ Software downloads

$ Technical knowledge database (FAQ)

$ On line manuals and documentation

$ Access to third-party software support sites

2. Personalized one-to-one technical support:

Agfa assists you on line if you have additional questions about technical issues.

3. Automatic e-mail notification:

Agfa notifies you immediately when new software and upgrades are available for downloading.

# Note: For support issues, go to http://support.agfa.com.

# Note: For the latest information consult the ScanWise Read Me File.

5 Click Install Adobe Acrobat Reader to install this program, if needed.

You need Adobe Acrobat Reader to read the SnapScan documentation.

http://support.agfa.com/
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6 Click View the ScanWise movie to see the demo.

When the software is installed you may be asked to restart your computer.

You are now ready to connect the scanner to your computer.
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Connecting the Scanner to the Macintosh
Computer

Caution: For your safety, use the adapter that comes with this product. Do not use any substitute.
Misuse of the power adapter can cause serious damage to the product and a safety hazard while
using it.

# Note: Check if the AC Adapter complies with your local power supply.

# Note: Make sure the scanner is unlocked (see Unlocking the Scanner) before connecting it to
the electric outlet.

1 Connect the Transparancy option as shown in the figure below (e52 only).

2 Connect the plug of the AC adapter to your scanner.

3 Plug the adapter cable in the wall outlet.

4 Connect one end of your USB cable to the USB port on your scanner.

Make sure you connect the correct plug as shown in the figure below.

5 Connect the other end of your USB cable to a USB port on your computer.

Make sure you connect it to the correct port as shown in the figure. A USB port is marked with
the USB icon ( ).
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Installing Additional Software
If you want to use OCR (Optical Character Recognition) you will have to install Readiris. Insert the
CD-ROM and follow the instructions on your screen.

For a general overview of the possible workflow, please consult the ScanWise modes document,
that is supplied with your scanner.
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Chapter 5: Configuring Buttons on Your
Macintosh Computer

! Selecting a Different ScanWise Configuration

! Modifying an Existing Configuration

! Creating a New Configuration

! Modifying the ScanWise Settings



Chapter 5: Configuring Buttons on Your Macintosh Computer 41

Selecting a Different ScanWise Configuration
It is possible to assign a different configuration to one of the four buttons of your SnapScan.
Following example will show you how it is done.

In this example we will change the settings of the e-mail button into a configuration that will send
the scanned image to a file.

1 Open the Agfa ScanWise software.

2 Select Configure Buttons from the Tools menu.

The Configure Buttons window appears.

a. e-mail button

b. print button

c. ScanWise button

d. OCR button

3 Click the drop-down list next to the e-mail button.

4 Select Scan Image to File (autoselect).

5 Click OK.

Pushing the e-mail button will send the scanned image to a file instead of to your mail
recipient.

# Note: The same procedure can be applied to the print, ScanWise and OCR button.
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Modifying an Existing Configuration
It is possible to modify an existing configuration and assign it to one of the four buttons of your
SnapScan. The following example will show you how this is done.

In this example we will change the settings of the e-mail button into a configuration that will send
the scanned image to a file instead of to your mail recipient.

1 Open the Agfa ScanWise software.

2 Select Configure Buttons from the Tools menu.

The Configure Buttons window appears.

a. e-mail button

b. print button

c. ScanWise button

d. OCR button
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3 Click Organize.

The Organize Actions window appears.

The Organize Actions window displays all predefined and user defined configurations.

# Note: Remove will be enabled when a user defined action is selected. The default actions
cannot be removed.

4 Select Scan Image to File (autoselect).

5 Click Edit to modify the selected configuration.

The Settings For window appears.

a. All predefined settings are available via the different drop-down menus.

b. The resolution depends on the choice of destination.

c. The output dimensions can be managed via the Dimension drop-down list.

# Note: There are several options to edit the existing configuration. For more information see
Modifying the ScanWise Settings.
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6 Click Save As.

The Save Action Configuration window appears.

7 Enter the name of your configuration.

8 Click OK.

You return to the Settings For window.

9 Click OK.

You return to the Organize Actions window and your configuration will be added to the Actions
list.

10 Click Close.

You return to the Configure Buttons window.

11 Select My Scan Image to File (autoselect) from the drop-down list next to the e-mail button.

12 Click OK.

Pushing the e-mail button will send the scanned image to a file instead of to your mail
recipient.

# Note: For low quality originals (originals that are too bright or too dark), we advice you to select
the PhotoGenie check box, which will enhance the colors.
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Creating a New Configuration
It is possible to create a new configuration and assign it to one of the four buttons of your
SnapScan. The following example will show you how this is done.

In this example we will create a new configuration and assign it to the e-mail button.

1 Open the Agfa ScanWise software.

2 Select Configure Buttons from the Tools menu.

The Configure Buttons window appears.

a. e-mail button

b. print button

c. ScanWise button

d. OCR button

3 Click Organize.

The Organize Actions window appears.
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The Organize Actions window displays all predefined and user defined configurations.

# Note: Remove will be enabled when a user defined action is selected. The default actions
cannot be removed.

4 Click New in the Organize Actions window.

The Settings For window appears.

a. All predefined settings are available via the different drop-down menus.

b. The resolution depends on the choice of destination.

c. The output dimensions can be managed via the Dimension drop-down list.

# Note: There are several options to create a new configuration. For more information see
Modifying the ScanWise Settings.

5 Select the settings that you want to apply.

6 Click Save As.

The Save Action Configuration window appears.

7 Enter the name of your configuration.

8 Click OK.

You return to the Settings For window.

9 Click OK.

You return to the Organize Actions window and your configuration is added to the Actions list.



Chapter 5: Configuring Buttons on Your Macintosh Computer 47

10 Click Close.

You return to the Configure Buttons Window.

11 Select your new configuration from the drop-down list next to the e-mail button.

12 Click OK.

The e-mail button is configured with your personal settings.

Modifying the ScanWise Settings
There are several options to edit the existing configuration or to create a new one.

In the Settings For window following options are available:

" Original Type, Destination, Selection and Color Mode: These options can be changed using
the different drop-down menus.

" Use PhotoGenie: Select the check box Use PhotoGenie if you want to activate the PhotoGenie
software that will enhance both color and detail of your scanned image in case it is too bright
or too dark.

" Resolution: The resolution depends on the destination. If you select your printer as a
destination, the resolution of your printer destination will be shown in the Resolution box.
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" Dimension: If you want a specified output range, click the Dimension drop-down list. A list of
additional options will appear. Select the dimension (width or height) you want to specify. Enter
the desired range and select the correct unit from the popup list. The Keep original size
selection will keep the original size of the image.
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Chapter 6: Making Your First Scan

1 Place a color photograph face down on the glass plate with the top side against the middle of
the front ruler.

The optical performance of a CCD scanner is always best near the middle of the glass plate.
However, the specified scan quality is guaranteed for the entire scan area.
If you put more than one original on the glass plate, position them as close to the center line as
possible to optimize the quality.

2 Close the document cover of the scanner.

# SnapScan e52 note: Please make sure the transparency lamp cover is attached.

# Note: The adjustable document cover makes it possible to scan from books and
magazines. When you put a thick original on the reflective glass plate, the document
cover adapts to the thickness of the original.
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3 For PC: In the Start menu, select Programs, Agfa ScanWise, ScanWise to open the ScanWise
application.

-or-

For Macintosh: Go to the Agfa ScanWise folder on your hard disk and double-click .

4 Select your scanner (if needed).

# Note: This dialog only appears the first time you use ScanWise.

5 Click Yes when the system asks to guide you.

6 Follow the steps described in the ScanWise Guide Me mode.

For more information consult the ScanWise Application Guide and the Agfa Contacts on your Agfa
ScanWise CD-ROM. After installation you can access these documents via the Start menu or in
your ScanWise folder.

# Note: If you encounter problems, please consult the ScanWise Read Me file on your computer
or Appendix A: Troubleshooting in this Owner’s Guide.
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Chapter 7: Using the Transparency Module
(SnapScan e52 only)

To scan negatives, transparencies or slides you have to use the transparency module on your
SnapScan e52.

If you want to scan negatives, transparencies or slides carry out the following instructions:

1 Remove the transparency lamp cover (e52 ONLY).

2 If you scan negatives or transparencies:

1 Slide these negatives/transparencies in the holder.
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2 Align the holder with the negatives/transparencies on the scanner glass plate. Then,
continue with instruction 4.

3 If you scan slides:

1 Align the holder on the scanner glass plate.
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2 Position the original slide in the holder.

4 Close the document cover.

5 Click the ScanWise icon to start the program.

The Agfa ScanWise window opens.

6 Click the arrow on the Preview button to switch between transparencies and reflectives.

Transparent scanning:

Reflective scanning:

7 Click the Preview button (Mac only).

8 In case ScanWise has not automatically recognized the original, select the correct original
from the list.

9 Click the Scan button.

The negatives, transparencies or slides will be scanned.

# Note: Make sure the calibration area of the slide holder is NEVER covered. If the
calibration area is covered, the following message will appear:

# Note: If you are working on a PC, a similar message for PC will be displayed.
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calibration area

calibration area

! Note: Please make sure not to touch the glass plate in the calibration area. Otherwise the
quality of your scanned image can be affected.
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Appendix A: Troubleshooting

This section gives solutions for some common problems you may come across when starting up or
using your SnapScan.

There is no USB port free for your scanner.

" Check if you can use a USB port on the keyboard or monitor.

" Use a USB hub.

The status indicator fails to light up.

" Verify the power connection to the scanner.

" If the power connection is working, contact your dealer or local Agfa support center.

The scanner makes an unusual noise and the scanner lamp does not move back and forth
when you connect the scanner.

" The scanner was not properly unlocked. Immediately disconnect the AC adapter and unlock
the scanner properly, or contact your dealer or local Agfa support center.

The scanner or transparency lamp flickers, dims, or fails to light up.

" The cold cathode lamp of your scanner or the transparency module needs to be replaced.
Contact your dealer or local Agfa support center.

ScanWise cannot find the scanner (MACINTOSH ONLY).

If the scanner driver cannot find the scanner, a message appears telling you that no scanner is
connected.

" Check if the scanner is connected with the USB cable to your computer and that the AC
adapter is plugged in. It can always happen that a USB port is damaged, therefore try the other
USB port of your computer.

" Open the Apple System Profiler that you find under the  menu. Click the tab ‘Devices and
Volumes’ (minimum version 8.5). Here you can check if the USB device is found. If USB is not
present in the list of ‘Devices and Volumes’, please check the hardware (cable, USB ports, ...).

" Disconnect the AC adapter and reconnect it again.

# Note: If you encounter other problems during or after installation, please consult the ScanWise
Read Me file on your computer.

The driver is not found when you connect the scanner to your computer (MACINTOSH ONLY).

If ScanWise is not installed correctly, the following message appears: “The software needed to use
the device SNAPSCAN cannot be found”.

" Re-install ScanWise.

" Check if the Extensions folder contains the file ‘Agfa USB’ e42 or ‘Agfa USB e52’. These
drivers are necessary for detecting the respective scanner.
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Windows 98 fails to detect the scanner when you connect it for the first time (PC ONLY).

" Check if the scanner is connected with the USB cable to your computer and that the AC
adapter is plugged in. It can always happen that a USB port is damaged, therefore try the other
USB port of your computer.

" Check if the Device Manager finds the USB controller. To check if the USB controller is
present in the Device Manager, click with the right mouse button on the icon My Computer and
select Properties from the menu that pops up. Select the Device Manager tab from the System
Properties dialog box.

$ If the USB controller ( ) is present in the Device Manager, carry out the scanner
installation procedure exactly as described in this manual.

$ If the USB controller is not present in the Device Manager, carry out the following
instructions:

1 Restart your computer.

2 Enable the USB controller in the BIOS settings.

Caution: Changing your computer’s BIOS settings is at your own risk! It should be
done by system administrators and experienced users only. If you are not familiar
with these tasks, ask your computer dealer to do this for you.

You typically do this by pressing a key combination during the startup of your PC.
Consult your computer manual for more information.

3 Exit and save the changes you made.

Your computer is rebooted automatically.

" Check again if the Universal serial bus controller is present in the Device Manager.

$ If the Universal serial bus controller ( ) is present in the Device Manager, carry out the
scanner installation procedure exactly as described in this manual.

$ If the Universal serial bus controller is still not present in the Device Manager, carry out
the following instructions:

1. Click the Start button.

2. Select Settings.

3. Select Control Panel.

4. Double-click on the Add New Hardware icon.

5. Attentively follow the instructions that appear on your screen.

The Universal Serial Bus controller should now be present in the Device Manager. Carry out the
scanner installation procedure exactly as described in this manual.

An OEM Windows 98 system was already installed when purchasing your computer (PC
ONLY).

When you encounter problems during the installation procedure on a PC with a pre-installed
Windows 98 system, please contact your PC dealer.
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The e-mail function is not working (PC ONLY).

ScanWise PC uses the default MAPI (Microsoft Messaging API) client as e-mail destination. This
means you need a MAPI compatible e-mail client and it also has to be configured correctly. If
ScanWise cannot find such a destination, the e-mail destination will NOT be visible in the
destination list.

Examples of MAPI compatible clients: Microsoft Outlook and Outlook Express, Netscape
Messenger, Eudora Pro.
Example of a non MAPI compatible client: Compuserve for Windows.

Some configuration examples:

" If you are using MS Outlook Express v4.x and it does not show up in the ScanWise destination
list, choose Options in the Tools menu in Outlook Express and make sure that the following
items are checked:

$ Make Outlook Express my default e-mail program.

$ Make Outlook Express my default Simple MAPI client.

This should solve the problem.

" If you are using MS Outlook Express v5, choose Tools, General in the Tools menu in MS
Outlook Express. If Outlook is not the default e-mail client, click the ‘Make default’ button.

" You can also choose Internet Options, Programs in the Control Panel and indicate your e-mail
client there.

# Note: If ScanWise cannot find an e-mail destination, ScanWise will ask you to assign another
action to the default e-mail button of your scanner.
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Appendix B: Technical Information
Technical specifications are subject to change without notice.

Scanner type:

SnapScan e42

SnapScan e52

Desktop, flatbed, one pass, 4 buttons of which all are
software definable

Desktop, flatbed, one pass, 4 buttons of which all are
software definable and transparency module

Maximum resolution:
- optical: 1200 ppi horizontal x 2400 ppi vertical

- through interpolation: 9600 ppi horizontal x 9600 ppi vertical

- Internal sample depth: 16 bits for gray, 48 bits for color
Scanning speed:
- line-art: 8 ms / line

- gray: 8 ms / line

- color: 23 ms / line

Maximum scanning area (for
reflective scanning only):

216 x 297 mm (8.5 '' x 11.7 '')

Maximum scanning area for
transparency scanning
(SnapScan e52):

5 negatives or transparencies

3 slides

Lamp for reflective scanning: Cold cathode

Lamp for transparent scanning
(SnapScan e52):

Cold cathode

Power-on to ready time: 15 seconds

AC-adapter:

- Input voltage:

- Input frequency:

100 to 240 V

47 to 63 Hz

Power consumption: 25 W
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Dimensions:
- length SnapScan e42: 496 mm (19.5 “)

- length SnapScan e52: 501 mm (19.7 “)

- width: 337 mm (13.3 “)

- height: 94 mm (3.7 “)

- weight SnapScan e42: 3.9 kg (8.6 lb)

- weight SnapScan e52: 4.2 kg (9.24 lb)

Interface: USB port

Transmission speed: 1 mbyte/s

Environmental specifications:

- operating temperature: +10 °C to +40 °C (+50 to +104 degrees Fahrenheit)

- relative humidity: 20% to 85% RH

- surrounding space: 10 cm (4 “) on every side
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Appendix C: Regulation Compliance
! Safety Regulations

! Electromagnetic Compatibility

! Declaration of Conformity: SnapScan e42/e52



Appendix C: Regulation Compliance 61

Safety Regulations
SnapScan and its options are designed to comply with:

" UL 1950

" CSA C22.2 No. 950 - M89 D3

" VDE 0805

" IEC 950

" GS approved

" EN 60950

UL Safety Statement

The SnapScan and the AC adapter are suited for indoor use only. Do not use them outdoors.

Use the Agfa supplied AC adapter only, otherwise guarantee will be voided.

For the reason of safety, besides the personal maintenance mentioned in this operation manual, do
not try to remove any mechanical parts or any electronic devices. If your scanner needs service, our
dealer and service offices are available to help you.

TÜV: Wichtige Sicherheitshinweise

Bitte Lesen Sie sich diese Hinweise sorgfältig durch.

Um eine Beschädigung des Gerätes zu vermeiden sollten Sie nur Zuberhörteile verwenden, die
vom Hersteller zugelassen sind.

Das Gerät ist vor Feuchtigkeit zu schützen.

Bei der Aufstellung des Gerätes ist auf sicheren Stand zu achten. Ein Kippen oder Fallen könnte
Verletzungen hervorrufen. Verwenden Sie nur sichere Standorte und beachten Sie die
Aufstellhinweise des Herstellers.

Die Belüftungsöffnungen dienen zur Luftzirkulation die das Gerät vor Überhitzung schütz. Sorgen
Sie dafür, daß diese Öffnungen nicht abgedeckt werden.

Die Netzanschlußsteckdose muß aus Gründen der elektrischen Sicherheit einen
Schutzleiterkontakt haben.

Durch die Lüftungsöffnungen dürfen niemals Gegenstände oder Flüssigkeiten in das Gerät
gelangen. Dies könnte einen Brand bzw. elektrischen Schlag auslösen.

Öffnen Sie niemals das Gerät. Das Gerät darf aus Gründen der elektrischen Sicherheit nur von
authorisiertem Servicepersonal geöffnet werden.

Die Steckdose sollte nahe dem Gerät und leicht zugänglich sein.
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Electromagnetic Compatibility
SnapScan is designed to comply with:

" Emission EN55022, class B

" Immunity IEC 801-2, IEC 801-3, IEC 801-4

" 47 CFR, part 15, subpart B, class B

Federal Communications Commission Radio Frequency
Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a residential installation. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

" Reorient or relocate the receiving antenna.

" Increase the separation between the equipment and receiver.

" Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

" Consult the dealer or an experienced radio/television technician for help.

Industry Canada Class A and B Label Requirements

This Class [select A or B] digital apparatus meets all the requirements of the Canadian Interference
Causing Equipment Regulations.

Cet appareil numérique de la classe [A/B] respecte toutes les exigences du Règlement sur le
matériel brouilleur du Canada.
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Declaration of Conformity: SnapScan e42/e52

Manufacter’s authorized:

Georges Brys

Agfa-Gevaert N.V.

Septestraat 27

B-2640 Mortsel

Declares that the product

Agfa SnapScan e42/e52

Color image scanner

Complies with the requirements of the Low Voltage Directive 73/23/EEC, 93/68/EEC

The product SnapScan e42/e52 complies with the following standards:

EN 60950: 1992/A1: 1993

Complies with the requirements of the EMC directive 89/336/EEC

The product SnapScan e42/e52 complies with the following standards:

EN 55022 class B

EN 50082 – 1 -,

IEC 801-2, IEC 801-3, IEC 801-4

The product is marked with the CE marking.

Georges Brys

General Manager business group Consumer Imaging

Agfa-Gevaert N.V.
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